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In This Guide…
This guide contains the following information: 

1    Quick-Start

This chapter explains how to initialize the signal analyzer and view a signal.

2    Front and Rear Panel Features

Refer to this chapter for information on front- and rear-panel key functionality, and display annotations.

3    Instrument Operating System

This chapter describes the Microsoft Windows XP configuration and the settings used with the Agilent 
instrument software. 

4    Using Microsoft Windows XP

The information in this chapter provides some guidelines for using the Microsoft Windows XP feature 
capabilities with the signal analyzer.

5    Troubleshooting

This chapter details some basic steps that may solve any problems you are experiencing with either the 
signal analyzer or Microsoft Windows XP.



Warranty
This Agilent technologies instrument product is warranted against defects in material and workmanship for 
a period of one year from the date of shipment. During the warranty period, Agilent Technologies will, at 
its option, either repair or replace products that prove to be defective.

For warranty service or repair, this product must be returned to a service facility designated by Agilent 
Technologies. Buyer shall prepay shipping charges to Agilent Technologies and Agilent Technologies shall 
pay shipping charges to return the product to Buyer. However, Buyer shall pay all shipping charges, duties, 
and taxes for products returned to Agilent Technologies from another country.

Where to Find the Latest Information
Documentation is updated periodically. For the latest information about this analyzer, including firmware 
upgrades, application information, and product information, see the following URLs:

http://www.agilent.com/find/mxa
http://www.agilent.com/find/exa

To receive the latest updates by email, subscribe to Agilent Email Updates:

http://www.agilent.com/find/emailupdates

Information on preventing analyzer damage can be found at:

http://www.agilent.com/find/tips

http://www.agilent.com/find/mxa
http://www.agilent.com/find/exa
http://www.agilent.com/find/exa
http://www.agilent.com/find/tips


Contents
1 Quick-Start

Initial Inspection 10
Table. Verifying the contents 10
Shipping problems? 11
Instrument Location and Rack Mounting Requirements 11

Turning on the Analyzer the First Time 12
Initializing the analyzer using a USB mouse 12
Initializing the analyzer using front-panel navigation 17

Anti-Virus Software and Firewalls 21

Shortening the Instrument Power-On Time 22

Instrument Information 23
Power requirements 23
Instrument Maintenance 24
Protecting against electrostatic discharge 25

2 Front and Rear Panel Features
Overview of key types 30

Display Annotations 32

Rear-Panel Features 34

Front and Rear Panel Symbols 36

3 Instrument Operating System

Agilent Software Installed 38
Agilent signal analyzer software 38
Agilent 89601A 38

Customer Installation of Software 39
3rd party software verified by Agilent 39
Installation of other 3rd party software 39

User Accounts 40
Administrator login 40
User login 40
AgilentOnly user account 40
Getting Started Guide 5



Agilent service user accounts 40
Customer creation of accounts 41

Agilent X-Series Analyzer Licensing Options 42
Fixed perpetual 42
Transportable perpetual 42

Licensing New Measurement Application Software - After Initial Purchase 44

Windows Configuration 46
Settings that can be changed 46
Settings that must not be changed 47

Configuring Printers 49

Configuring LAN 50
Hostname 50
IP Address & Gateway 50

Windows Security 51
Windows Firewall 52
Automatic updates 52
Virus protection 53
Spyware protection 54

System Maintenance 55
Backup 55
System restore 55
Disk defragmenting 55

USB Connections 56

Hard Drive Partitioning and Use 57
Backing-up the factory calibration data 58

Hard Drive Recovery Process 59
Configuring recovery prompt timing 61

4 Using Microsoft Windows XP

Navigating Windows Without a Mouse 64

Remote Desktop: Using the X-Series Signal Analyzers Remotely 68
Overview of Remote Desktop operation 68
Setting up Remote Desktop operation 68
How to locate the computer name of the instrument 70
Running a Remote Desktop session 72
6 Getting Started Guide



The Virtual Front Panel 81

Embedded Web Server: Using the X-Series Signal Analyzers Remotely 82
Accessing the instrument through the Internet 82
Accessing the Web Control SA tab 86
Selecting the Get Data tab 87
Selecting the Get Image tab 88
Selecting the SCPI Telnet tab 90
Selecting the Help tab 92

Capturing/Printing Displays and Windows 93

Windows Shortcuts and Miscellaneous Tasks 94
Windows shortcuts (key combinations) 94
Windows taskbar auto-hide feature 95
Windows startup folder 97

5 Troubleshooting

Check the Basics 100

Problems with Microsoft Windows XP 102

Returning an Analyzer for Service 103
Calling Agilent Technologies 103
Locations for Agilent Technologies 103
Read the Warranty 103
Service Options 103
Service Tag 104
Packaging the Instrument 105

Index
Getting Started Guide 7



8 Getting Started Guide



Agilent X-Series Signal Analyzers
Getting Started Guide
1
Quick-Start

This section explains how to initialize the Signal Analyzer and view a signal.

The following topics can be found in this section:

“Initial Inspection" on page 10

“Instrument Location and Rack Mounting Requirements" on page 11

“Turning on the Analyzer the First Time" on page 12

“Anti-Virus Software and Firewalls" on page 21

“Shortening the Instrument Power-On Time" on page 22

“Instrument Information" on page 23
9Agilent Technologies



1 Quick-Start
Initial Inspection

Inspect the shipping container and the cushioning material for signs of stress. Retain the 
shipping materials for future use, as you may wish to ship the analyzer to another 
location or to Agilent Technologies for service.

Verifying the contents

Item Deliverable Description

Getting Started Guide Provides first-time power on instructions, 
licensing information, operating system 
information, and general hardware 
information.

Documentation disk PDF files for all manuals (except service), 
programming example files, and some 
technical Application Notes.

Agilent IO Libraries disk Software for establishing and configuring 
PC to instrument interfaces.

 Optical mouse An optical USB mouse to simplify screen 
navigation.

N9060A Measurement 
Guide 

Spectrum Analyzer Measurement 
Application. 
For use with N9020A MXA Signal 
Analyzer and N9010A EXA Signal 
Analyzer.

Power cable Connection for instrument power. 
10 Getting Started Guide



Quick-Start 1
Shipping problems?

If the shipping materials are damaged or the contents of the container are incomplete:

• Contact the nearest Agilent Technologies office. 
• Keep the shipping materials for the carrier’s inspection.
• If you must return an analyzer to Agilent Technologies, use the original (or 

comparable) shipping materials. See “Returning an Analyzer for Service" on 
page 103.

Instrument Location and Rack Mounting Requirements

Locating the analyzer

Make sure that the fan inlet and exhaust vent areas on the sides of the analyzer are not 
obstructed. The minimal required clearance is 2 inches. Airflow restrictions cause 
additional airflow noise and cause the fans to speed up so they can draw in enough air for 
the required cooling resulting in excessive audible noise.

Cooling and rack mounting

Do not rack mount the analyzer side-by-side with any other instrument with side-by-side 
ventilation. Make sure the exhaust air from the first instrument is directed away from the 
inlet of the second unit. If the pre-heated air from the first instrument is directed into the 
second instrument, it can cause excessive operating temperatures in the second unit and 
can cause instrument failures. The analyzer draws air in from the left side and exhausts 
air from the right side.
Getting Started Guide 11



1 Quick-Start
Turning on the Analyzer the First Time

Initial power-on of the analyzer can be accomplished using either of the following 
methods:

• “Initializing the analyzer using a USB mouse" on page 12
• “Initializing the analyzer using front-panel navigation" on page 17

Initializing the analyzer using a USB mouse

During the initial power-on process, the instrument turns off and restarts 
several times. This only happens during the initial installation process.

Steps Actions Notes

1 Connect the mouse • Connect the mouse to one 
of the analyzer’s USB 
ports. 

2 Power on the analyzer a Position the analyzer so 
you have easy access to the 
power cord and plug it in.

b Press the power switch 
(located in the lower left 
corner of the analyzer’s 
front panel) to turn the 
analyzer on.

The Agilent Technologies 
screen appears followed by a 
screen that allows you to 
select the operating system.

• See “Instrument Location and Rack Mounting 
Requirements and “Power requirements" on page 23 
for more details.

• The analyzer can require more than 5 minutes to 
power-on. This is affected by Windows XP start-up 
requirements.

• At this time, it is safe to turn off the instrument 
before starting the Setup Wizard.

 After launching the Setup Wizard, do not turn off the instrument or remove power 
before the Setup Wizard completes and the system restarts. Turning off the instrument 
may corrupt the system and the application may not operate. 
12 Getting Started Guide



Quick-Start 1
3 Launch Microsoft Setup 
Wizard

a Highlight Microsoft 
Windows XP Professional 
and press Enter to start the 
pre-installed operating 
system. 

• The analyzer performs the following steps before the Setup Wizard starts:
• Windows XP Startup window
• Black screen
• Blue message window “Please wait while windows prepares to start”
• Blue screen
• Windows XP Setup dialog box “Please Wait”

4 Start the Windows XP 
Professional Setup

a When the Windows XP 
Setup Wizard window 
comes up, click Next.

• This takes you to the End-User License Agreement 
window.

5 Accept the End-User 
License Agreement 
(EULA)

• Position the cursor and use 
the left mouse button to 
accept the terms of the 
End-User License 
Agreement for Windows 
XP.

• You must accept this agreement to continue the 
Windows XP installation and configuration.
If you do not accept this agreement, the analyzer 
shuts down and the next time you turn it on the 
Windows XP Setup Wizard starts from the 
beginning.

Steps Actions Notes
Getting Started Guide 13



1 Quick-Start
6 Set the System Date and 
Time

a Position the cursor and use 
the left mouse button to 
navigate the Date and Time 
Settings screen.

b Click Next.

After accepting the time and date screen the Windows XP Setup Wizard continues and 
the analyzer restarts two or three times. After the first restart the following window 
appears:

c Click OK.
Before the last restart, the following window appears:

Steps Actions Notes
14 Getting Started Guide



Quick-Start 1
When the analyzer restarts, the following message appears:

If you do not check the “Do not show this message again” check box, this message will 
be displayed each time the analyzer is turned on. No application will start while this 
message is displayed.
 Before continuing, make sure that you carefully read the Anti-Virus message and 
determine what action is appropriate.

7 Disable the Anti-Virus 
message

a Select the check box and 
click Continue.

8 Configure applications to 
be pre-loaded on startup

If you have installed 5 or more applications, the following window may appear:

Select the applications you want to pre-load and click OK.

Steps Actions Notes
Getting Started Guide 15



1 Quick-Start
9 Verify the installation a On the instrument, press 
System, Show, System.

b Verify that the purchased 
application(s) appear in the 
list.

• If you require further assistance, contact the Agilent 
support team.
Online assistance: http://www.agilent.com/find/assist

10 View a signal a Press Input/Output, 
RF Calibrator, 50 MHz.

b Press AMPTD Y Scale, 10, 
dBm.

c Press FREQ Channel, 
Center Freq, 40, MHz.

d Press SPAN X Scale, 50, 
MHz.

• This routes the internal 50 MHz signal to the 
analyzer input.

• Sets the reference level to 10 dBm.

The 50 MHz reference signal appears on the display.

Steps Actions Notes
16 Getting Started Guide
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Quick-Start 1
Initializing the analyzer using front-panel navigation 

The following keys are used in the initialization process:

Arrow keys Enter key Tab keys Select key

Steps Actions Notes

1 Power on the analyzer a Position the analyzer so 
you have easy access to the 
power cord and plug it in.

b Press the power switch 
(located in the lower left 
corner of the analyzer’s 
front panel) to turn the 
analyzer on.

The Agilent Technologies 
screen appears followed by a 
screen that allows you to 
select the operating system.

• See “Instrument Location and Rack Mounting 
Requirements and “Power requirements" on page 23 
for more details.

• The analyzer can require more than 5 minutes to 
power-on. This is affected by Windows XP start-up 
requirements.

• At this time, it is safe to turn off the instrument before 
starting the Setup Wizard.

After launching the Setup Wizard, do not turn off the instrument or remove power before 
the Setup Wizard completes and the system restarts. Turning off the instrument may 
corrupt the system and the application may not operate. 
Getting Started Guide 17



1 Quick-Start
2 Launch the Microsoft 
Setup Wizard

a Highlight Microsoft 
Windows XP Professional 
and press Enter to start the 
pre-installed operating 
system. 

• The analyzer goes through the following steps:
• Windows XP Startup window
• Black screen
• Blue message window “Please wait while windows prepares to start”
• Blue screen
• Windows XP Setup dialog box “Please Wait”

3 Start the Windows XP 
Professional Setup

a When the Windows XP 
Setup Wizard window 
comes up, press Enter.

• This takes you to the End-User License Agreement 
window.

4 Accept the End-User 
License Agreement 
(EULA)

a Press the Tab key to select 
the License Agreement text 
box.

b Use the up and down arrow 
keys to scroll through the 
user agreement text.

c Use the Tab keys to move 
the highlight to the 
agreement 
acknowledgement check 
boxes.

d Use the arrow keys to make 
a user agreement selection.

e Use the Tab keys to move 
the highlight to the 
navigation buttons (Back, 
Next).

f Use the arrow keys to 
highlight Next.

g Press Enter.

• You must accept this agreement to continue the 
Windows XP installation and configuration.
If you do not accept this agreement, the analyzer shuts 
down and the next time you turn it on the Windows 
XP Setup Wizard starts from the beginning.

Steps Actions Notes
18 Getting Started Guide



Quick-Start 1
5 Set the System Date and 
Time

a Press the Tab keys to move 
between items in the Date 
and Time Settings screen.

b Use the left and right arrow 
keys to move between the 
date and time items.

c Use the up and down arrow 
keys to scroll through the 
values for each item.

d Use the Space key to select 
or clear the “Automatically 
adjust clock for daylight 
saving changes” check box 
when it is the active item.

e Press Enter, or Tab then 
Enter to continue the 
Windows XP Setup 
Wizard.

After accepting the time and date screen the Windows XP Setup Wizard continues and 
the analyzer restarts two or three times. After the first restart the following window 
appears:

• Press Enter.
Before the last restart, the following window appears:

Steps Actions Notes
Getting Started Guide 19



1 Quick-Start
When the analyzer restarts, the following message appears:

If you do not check the “Do not show this message again” check box, this message will 
be displayed each time the analyzer is turned on. No application will start while this 
message is displayed.

Before continuing, make sure that you carefully read the Anti-Virus 
message and determine what action is appropriate.

6 Disable the Anti-Virus 
message

a Press Select to select the 
check box and Enter to 
continue.

7 Configure applications to 
be pre-loaded on startup

If you have installed 5 or more applications, the following window may appear:

a Use the Tab key and press Select to select the applications to be pre-loaded.
b Press Enter.

Steps Actions Notes
20 Getting Started Guide



Quick-Start 1
Anti-Virus Software and Firewalls

No anti-virus software is shipped with the analyzer. It is recommended that you install 
anti-virus software if your analyzer is connected to the LAN. Check with your IT 
department to see what they recommend. 

The analyzer is shipped with the Windows XP firewall enabled. Do not modify the 
default network settings as this may cause problems with the operating system of the 
analyzer.

8 Verify the installation a Press System, Show, 
System.

b Verify that the purchased 
application(s) appear in the 
list.

• If you require further assistance, contact the Agilent 
support team.
Online assistance: http://www.agilent.com/find/assist

9 View a signal a Press Input/Output, 
RF Calibrator, 50 MHz.

b Press AMPTD Y Scale, 10, 
dBm.

c Press FREQ Channel, 
Center Freq, 40, MHz.

d Press SPAN X Scale, 50, 
MHz.

• This routes the internal 50 MHz signal to the analyzer 
input.

• Sets the reference level to 10 dBm.

The 50 MHz reference signal appears on the display.

Steps Actions Notes
Getting Started Guide 21
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1 Quick-Start
Shortening the Instrument Power-On Time

The instrument desktop includes a shortcut to the ConfigureApplications.exe application 
that lets you control your instrument power-on configuration. You can set the 
configuration to pre-load only the applications that you typically run. This can 
significantly shorten the time it takes for your instrument to power-on. You can also 
access this functionality by pressing: System, Power On, Configure Applications.

If (after power-on) you want to access an application that you did not pre-load, it will 
take a little longer to bring it up once you press the application softkey. This longer 
time-frame is only for the first access after power-on. After the initial access, mode 
(application) switching will operate as quickly as if the application was pre-loaded.
22 Getting Started Guide



Quick-Start 1
Instrument Information

Power requirements

The only physical installation of your Agilent signal analyzer is a connection to a power 
source. Line voltage does not need to be selected. 

This analyzer does not contain customer serviceable fuses.

This is a Safety Class 1 Product (provided with a protective earthing 
ground incorporated in the power cord). The mains plug shall only be 
inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor inside or outside of the 
product is likely to make the product dangerous. Intentional 
interruption is prohibited. (IEC 348 clauses 17.3.3c & 17.3.4)

Failure to ground the analyzer properly can result in personal injury. 
Before turning on the analyzer, you must connect its protective earth 
terminals to the protective conductor of the main power cable. Insert 
the main power cable plug into a socket outlet that has a protective 
earth contact only. DO NOT defeat the earth-grounding protection by 
using an extension cable, power cable, or autotransformer without a 
protective ground conductor.

This product is designed for use in Installation Category II and Pollution 
Degree 2 per IEC 61010 Second Edition and IEC 664 respectively. 
This instrument has autoranging line voltage input. Be sure the supply 
voltage is within the specified range.

The Mains wiring and connectors shall be compatible with the connector 
used in the premise electrical system. Failure, to ensure adequate earth 
grounding by not using the correct components may cause product 
damage, and serious injury.
Getting Started Guide 23



1 Quick-Start
AC power cord

The analyzer is equipped with a three-wire power cord, in accordance with international 
safety standards. This cable grounds the analyzer cabinet when connected to an 
appropriate power line outlet. The cable appropriate to the original shipping location is 
included with the analyzer. See:

 http://www.agilent.com/find/powercords

Instrument Maintenance

Cleaning the instrument

Battery Information  

The analyzer uses a lithium battery located on the CPU board. This is not an operator 
replaceable part. See “Returning an Analyzer for Service" on page 103. Replaceable 
parts must be approved or supplied by Agilent Technologies.

You can order the service documentation for the instrument through your Agilent Sales 
and Service office. 

Always use the three-prong AC power cord supplied with this product. 
Failure to ensure adequate earth grounding by not using this cord can 
cause product damage.

If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.
Install the instrument so that the detachable power cord is readily 
identifiable and easily reached by the operator. The detachable power 
cord is the instrument disconnecting device. It disconnects the mains 
circuits from the mains supply before other parts of the instrument. 
The front panel switch is only a standby switch and is not a LINE 
switch. Alternatively, an externally installed switch or circuit breaker 
(which is readily identifiable and is easily reached by the operator) 
may be used as a disconnecting device.

To prevent electrical shock, disconnect the signal analyzer from 
mains before cleaning. Use a dry cloth or one slightly dampened with 
water to clean the external case parts. Do not attempt to clean 
internally.
24 Getting Started Guide

http://www.agilent.com/find/powercords
http://www.agilent.com/find/powercords


Quick-Start 1
Protecting against electrostatic discharge

Electrostatic discharge (ESD) can damage or destroy electronic components (the 
possibility of unseen damage caused by ESD is present whenever components are 
transported, stored, or used).

Test equipment and ESD

To help reduce ESD damage that can occur while using test equipment:

• Before connecting any coaxial cable to an analyzer connector for the first time each 
day, momentarily short the center and outer conductors of the cable together.

• Personnel should be grounded with a 1 MΩ resistor-isolated wrist-strap before 
touching the center pin of any connector and before removing any assembly from the 
analyzer.

• Be sure that all instruments are properly earth-grounded to prevent build-up of static 
charge.

• Perform work on all components or assemblies at a static-safe workstation.

• Keep static-generating materials at least one meter away from all components.

• Store or transport components in static-shielding containers.

• Always handle printed circuit board assemblies by the edges. This reduces the 
possibility of ESD damage to components and prevent contamination of exposed 
plating.

Danger of explosion if battery is incorrectly replaced. Replace only 
with the same or equivalent type recommended. Discard used 
batteries according to the manufacturer’s instructions.

Do not throw batteries away but collect as small chemical waste.

Do not use these first three techniques when working on circuitry with 
a voltage potential greater than 500 volts.
Getting Started Guide 25



1 Quick-Start
Additional information about ESD

For more information about ESD and how to prevent ESD damage, contact the 
Electrostatic Discharge Association (http://www.esda.org). The ESD standards 
developed by this agency are sanctioned by the American National Standards Institute 
(ANSI).
26 Getting Started Guide



Agilent X-Series Signal Analyzers
Getting Started Guide
2
Front and Rear Panel Features

This section describes the following features:

“Front-Panel Features" on page 28

“Display Annotations" on page 32

“Rear-Panel Features" on page 34

“Front and Rear Panel Symbols" on page 36
27Agilent Technologies



2 Front and Rear Panel Features
Front-Panel Features

Item
Description

# Name

1 Menu Keys Key labels appear to the left of the menu keys to identify the current function 
of each key. The displayed functions are dependent on the currently selected 
Mode and Measurement, and are directly related to the most recent key press.

2 Analyzer Setup Keys These keys set the parameters used for making measurements in the current 
Mode and Measurement.

3 Measurement Keys These keys select the Mode, and the Measurement within the mode. They also 
control the initiation and rate of recurrence of measurements.

4 Marker Keys Markers are often available for a measurement, to measure a very specific 
point/segment of data within the range of the current measurement data.

5 Utility Keys These keys control system-wide functionality such as:

•  instrument configuration information and I/O setup,
•  printer setup and printing,
•  file management, save and recall,
•  instrument presets.

6 Probe Power Supplies power for external high frequency probes and accessories.

7 Headphones Output Headphones can be used to hear any available audio output.

8 Back Space Key Press this key to delete the previous character when entering alphanumeric 
information. It also works as the Back key in Help and Explorer windows.

9 Delete Key Press this key to delete files, or to perform other deletion tasks.
28 Getting Started Guide



Front and Rear Panel Features 2
10 USB Connectors Standard USB 2.0 ports, Type A. Connect to external peripherals such as a 
mouse, keyboard, DVD drive, or hard drive.

11  Local/Cancel/(Esc) Key If you are in remote operation, Local: 

• returns instrument control from remote back to local (the front panel). 
• turns the display on (if it was turned off for remote operation). 
• can be used to clear errors. (Press the key once to return to local control, 

and a second time to clear error message line.)

If you have not already pressed the units or Enter key, Cancel exits the 
currently selected function without changing its value.

Esc works the same as it does on a pc keyboard. It: 

• exits Windows dialogs
• clears errors
• aborts printing
• cancels operations.

12 RF Input Connector for inputting an external signal. Make sure that the total power of 
all signals at the analyzer input does not exceed +30 dBm (1 watt).

13 Numeric Keypad Enters a specific numeric value for the current function. Entries appear on the 
upper left of the display, in the measurement information area.

14 Enter and Arrow Keys The Enter key terminates data entry when either no unit of measure is needed, 
or you want to use the default unit.

The arrow keys:

• Increment and decrement the value of the current measurement selection.
• Navigate help topics.
• Navigate, or make selections, within Windows dialogs.
• Navigate within forms used for setting up measurements.
• Navigate within tables.

  The arrow keys cannot be used to move a mouse 
pointer around on the display.

15 Menu/ (Alt) Key Alt works the same as a pc keyboard. Use it to change control focus in 
Windows pull-down menus.

16 Ctrl Key Ctrl works the same as a pc keyboard. Use it to navigate in Windows 
applications, or to select multiple items in lists.

17 Select / Space Key Select is also the Space key and it has typical pc functionality. For example, in 
Windows dialogs, it selects files, checks and unchecks check boxes, and picks 
radio button choices. It opens a highlighted Help topic.

18 Tab Keys Use these keys to move between fields in Windows dialogs.

19 Knob Increments and decrements the value of the current active function.

20 Return Key Exits the current menu and returns to the previous menu. Has typical pc 
functionality.

Item
Description

# Name
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2 Front and Rear Panel Features
Overview of key types

The keys labeled FREQ Channel, System, and Marker Functions are all examples of 
front-panel keys. Most of the dark or light gray keys access menus of functions that are 
displayed along the right side of the display. These displayed key labels are next to a 
column of keys called menu keys.

Menu keys list functions based on which front-panel key was pressed last. These 
functions are also dependant on the current selection of measurement application (Mode) 
and measurement (Meas). 

21 Full Screen Key Pressing this key turns off the softkeys to maximize the graticule display area.

Press the key again to restore the normal display.

22 Help Key Initiates a context-sensitive Help display for the current Mode. Once Help is 
accessed, pressing a front panel key brings up the help topic for that key 
function.

23 Speaker Control Keys Enables you to increase or decrease the speaker volume, or mute it.

24 Window Control Keys These keys select between single or multiple window displays. They zoom the 
current window to fill the data display, or change the currently selected 
window. They can be used to switch between the Help window navigation 
pane and the topic pane.

25 Power Standby/ On Turns the analyzer on. A green light indicates power on. A yellow light 
indicates standby mode.

  The front-panel switch is a standby switch, not a LINE 
switch (disconnecting device). The analyzer continues 
to draw power even when the line switch is in standby. 

The main power cord can be used as the system 
disconnecting device. It disconnects the mains circuits 
from the mains supply.

26 Q Input Input port for the Q channel when in differential mode.*

27 Q Input Input port for the Q channel for either single or differential mode.*

28 I Input Input port for the I channel when in differential mode.*

29 I Input Input port for the I channel for either single or differential mode.*

30 Cal Out Output port for calibrating the I, I, Q and Q inputs and probes used with these 
inputs. *

* Status of the LED indicates whether the current state of the port is active (green) or is not in use (dark).

Item
Description

# Name
30 Getting Started Guide



Front and Rear Panel Features 2
If the numeric value of a menu key function can be changed, it is called an active 
function. The function label of the active function is highlighted after that key has been 
selected. For example, press AMPTD Y Scale. This calls up the menu of related 
amplitude functions. The function labeled Ref Level (the default selected key in the 
Amplitude menu) is highlighted. Ref Level also appears in the upper left of the display in 
the measurement information area. The displayed value indicates that the function is 
selected and its value can now be changed using any of the data entry controls.

Some menu keys have multiple choices on their label, such as On/Off or Auto/Man. The 
different choices are selected by pressing the key multiple times. For example, the 
Auto/Man type of key. To select the function, press the menu key and notice that Auto is 
underlined and the key becomes highlighted. To change the function to manual, press the 
key again so that Man is underlined. If there are more than two settings on the key, keep 
pressing it until the desired selection is underlined. 

When a menu first appears, one key label is highlighted to show which key is the default 
selection. If you press Marker Function, the Marker Function Off key is the menu default 
key, and is highlighted. 

Some of the menu keys are grouped together by a yellow bar running behind the keys 
near the left side or by a yellow border around the group of keys. When you press a key 
within the yellow region, such as Marker Noise, the highlight moves to that key to show 
it has been selected. The keys that are linked are related functions, and only one of them 
can be selected at any one time. For example, a marker can only have one marker 
function active on it. So if you select a different function it turns off the previous 
selection. If the current menu is two pages long, the yellow bar or border could include 
keys on the second page of keys.

In some key menus, a key label is highlighted to show which key has been selected from 
multiple available choices. And the menu is immediately exited when you press one of 
the other keys. For example, when you press the Select Trace key (in the Trace/Detector 
menu), it brings up its own menu of keys. The Trace 1 key is highlighted. When you 
press the Trace 2 key, the highlight moves to that key and the screen returns to the 
Trace/Detector menu.

If a displayed key label shows a small solid-black arrow tip pointing to the right, it 
indicates that additional key menus are available. If the arrow tip is not filled in solid 
then pressing the key the first time selects that function. Now the arrow is solid and 
pressing it again brings up an additional menu of settings.
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2 Front and Rear Panel Features
Display Annotations

This section describes the display annotation as it is on the Spectrum Analyzer 
Measurement Application display. Other measurement application modes have some 
annotation differences.

Item Description Function Keys 

1 Measurement bar - Shows general measurement 
settings and information.

Indicates single/continuous 
measurement.

Some measurements include limits that the data is 
tested against. A Pass/Fail indication may be shown in 
the lower left of the measurement bar.

All the keys in the Analyzer Setup 
part of the front panel.

2 Active Function (measurement bar) - when the current 
active function has a settable numeric value, it is 
shown here.

Currently selected front panel key.

3 Banner - shows the name of the selected application 
that is currently running.

Mode

4 Measurement title - shows title information for the 
current measurement, or a title that you created for the 
measurement.

Meas

View/Display, Display, Title
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5 Settings panel - displays system information that is not 
specific to any one application.

• Input/Output status - green LXI indicates the LAN 
is connected. RLTS indicate Remote, Listen, Talk, 
SRQ

• Input impedance and coupling
• Amplitude Correction Status
• Frequency reference selection 
• Setting of automatic internal alignment routine

Local and System, I/O Config

Input/Output, Amplitude, System 
and others

6 Active marker frequency, amplitude or function value Marker

7 Settings panel - time and date display. System, Control Panel

8 Trace and detector information Trace/Detector, 
Clear Write (W) Trace Average (A) Max 
Hold (M) Min Hold (m)
Trace/Detector,
More, 
Detector, 
Average (A) Normal (N) Peak (P) 
Sample (S) Negative Peak (p)

9 Key labels that change based on the most recent key 
press.

Softkeys

10 Displays information, warning and error messages. 
Message area - single events, Status area - conditions

System, Show, Errors

11 Measurement settings for the data currently being 
displayed in the graticule area. In the example above: 
center frequency, resolution bandwidth, video 
bandwidth, frequency span, sweep time and number of 
sweep points.

Keys in the Analyzer Setup part of 
the front panel.

Item Description Function Keys 
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2 Front and Rear Panel Features
Rear-Panel Features

MXA and EXA with Option PC2 

EXA

Item Description

# Name

1 EXT REF IN Input for an external frequency reference signal:

For MXA – 1 to 50 MHz 
For EXA – 10 MHz.
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2 GPIB A General Purpose Interface Bus (GPIB, IEEE 488.1) connection that can 
be used for remote analyzer operation. 

3 USB Connector USB 2.0 port, Type B. USB TMC (test and measurement class) connects to 
an external pc controller to control the instrument and for data transfers 
over a 480 Mbps link.

4 USB Connectors Standard USB 2.0 ports, Type A. Connect to external peripherals such as a 
mouse, keyboard, printer, DVD drive, or hard drive.

5 MONITOR Allows connection of an external VGA monitor. 

6 LAN A TCP/IP Interface that is used for remote analyzer operation. 

7 Line power input The AC power connection. See the product specifications for more details.

8 Removable Disk 
Drive

Standard on MXA. Optional on EXA.

9 Digital Bus Reserved for future use.

10 Analog Out Reserved for future use.

11 TRIGGER 2 
OUT

A trigger output used to synchronize other test equipment with the 
analyzer. Configurable from the Input/Output keys.

12 TRIGGER 1 
OUT

A trigger output used to synchronize other test equipment with the 
analyzer. Configurable from the Input/Output keys.

13 Sync Reserved for future use.

14 TRIGGER 2 IN Allows external triggering of measurements.

15 TRIGGER 1 IN Allows external triggering of measurements.

16 Noise Source 
Drive +28 V 
(Pulsed)

For use with Agilent 346A, 346B, and 346C Noise Sources

17 SNS Series Noise 
Source

For use with Agilent N4000A, N4001A, N4002A Smart Noise Sources 
(SNS).

18 10 MHz OUT An output of the analyzer internal 10 MHz frequency reference signal. It is 
used to lock the frequency reference of other test equipment to the 
analyzer. 

Item Description

# Name
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2 Front and Rear Panel Features
Front and Rear Panel Symbols

  This symbol is used to indicate power ON (green LED).

  This symbol is used to indicate power STANDBY mode (yellow 
LED).

  This symbol indicates the input power required is AC.

  The instruction documentation symbol. The product is marked with 
this symbol when it is necessary for the user to refer to instructions in 
the documentation.

  The CE mark is a registered trademark of the European Community.

  The C-Tick mark is a registered trademark of the Australian Spectrum 
Management Agency.

  This is a marking of a product in compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

This is also a symbol of an Industrial Scientific and Medical Group 1 
Class A product (CISPR 11, Clause 4).

  The CSA mark is a registered trademark of the Canadian Standards 
Association International.

  This symbol indicates separate collection for electrical and electronic 
equipment mandated under EU law as of August 13, 2005. All electric 
and electronic equipment are required to be separated from normal 
waste for disposal (Reference WEEE Directive 2002/96/EC).

To return unwanted products, contact your local Agilent office, or see 
http://www.agilent.com/environment/product/ for more information. 
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Agilent X-Series Signal Analyzers
Getting Started Guide
3
Instrument Operating System

This chapter describes the Microsoft Windows XP configuration and the settings used 
with the Agilent instrument software. It includes information about changing some of 
the system settings. And it describes the Windows operating system configuration and 
the software installations that are present on the Hard Disk Drive when the instrument 
leaves the factory.

The front panel of the analyzer has been designed with the keys needed to navigate 
windows for: accessing menus, traversing in dialogs, selecting items, and depressing 
displayed buttons. It is possible to use the front panel for changing Windows XP 
configuration items, but it is much easier to perform these tasks with a USB mouse and 
external keyboard. For specifics on navigating using the front panel, see “Navigating 
Windows Without a Mouse" on page 64.

The following topics can be found in this chapter:

“Agilent Software Installed" on page 38

“Customer Installation of Software" on page 39

“User Accounts" on page 40

“Agilent X-Series Analyzer Licensing Options" on page 42

“Licensing New Measurement Application Software - After Initial Purchase" on page 44

“Windows Configuration" on page 46

“Configuring Printers" on page 49

“Configuring LAN" on page 50

“Windows Security" on page 51

“System Maintenance" on page 55

“USB Connections" on page 56

“Hard Drive Partitioning and Use" on page 57

“Hard Drive Recovery Process" on page 59
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3 Instrument Operating System
Agilent Software Installed

Agilent signal analyzer software

The N9060A Agilent Spectrum Analyzer Measurement Application software is installed 
in the signal analyzer. Additional measurement applications are available. Each 
application requires a license to execute the software. All of these applications are 
installed by the factory at the time of manufacture, even if the licenses have not been 
purchased. You may purchase additional licenses at a later date.

Agilent 89601A

Agilent 89601A Vector Signal Analyzer (VSA) is installed. Agilent 89601A 
measurements requires a license to use the product beyond an initial 14 day trial period.
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Customer Installation of Software

3rd party software verified by Agilent

Agilent has verified that the following programs are compatible with the instrument 
applications:

• Symantec AntiVirus™ Corporate Edition version 9.0.0.338

• MathWorks MATLAB

Installation of other 3rd party software

The X-Series Signal Analyzer platform is an open Windows environment, so you can 
install non-approved software on the instrument. However, installation of non-approved 
software may affect instrument performance. Agilent does not warrant the performance 
of the analyzers with non-approved software installed.

If you install programs other than those that Agilent has tested, it could cause problems 
with the instrument's applications. If this happens, you should try uninstalling the 
program that has caused the problem, or try changing the program's configuration. If this 
does not correct the problem, you may have to use the Agilent Recovery system to 
reinstall the instrument's system software.

Before installing any additional programs on the instrument, you should 
exit the Signal Analyzer application.

Also, you must not remove any applications or programs that are installed 
on the instrument when it is shipped from the factory.
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User Accounts

Administrator login

The Administrator account ships from the factory with the password “agilent4u”. Using 
the Administrator account you can perform the following operations:

• Install software
• Configure network and printer access
• Access all files on the instrument
• Add or change user accounts and passwords
• Change Windows settings
• Run any application

User login

The default user account that ships from the factory is “Instrument” with the password 
“measure4u”. This user is a member of the Power Users group. Using the Instrument 
account you can perform the following operations:

• Install software
• Configure network and printer access
• Access files on the instrument that are accessible to the Power Users group
• Run applications that are accessible to the Power Users group

AgilentOnly user account

The instrument contains a user account called “AgilentOnly” that can be used by 
Agilent’s customer support in the event that the Administrator password was changed 
and has since been lost or forgotten. You must not remove or modify the AgilentOnly 
account.

Agilent service user accounts

User accounts are defined for Agilent’s use if it is necessary to service the instrument.
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Customer creation of accounts

You can create additional user accounts and decide on the level of security granted to any 
new user accounts created. For example, the level of security can be assigned as 
administrator, power user, user, backup operators. User names are not case sensitive but 
passwords are case sensitive.

It is Agilent’s expectation that each user’s My Documents folder is mapped to the D: 
drive. This is to avoid overwriting the user’s data in the event the Agilent Recovery must 
be performed. Also, this facilitates convenient backup by copying the contents of the D: 
drive to external media. All users accounts created by the factory already have My 
Documents mapped to the D: drive. Please map all new users My Documents folders to 
the D: drive.

For the Signal Analyzer software to operate, the user account executing the 
software must be assigned Administrator or Power User privileges. 
Otherwise, the Signal Analyzer software will not operate correctly. 
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Agilent X-Series Analyzer Licensing Options

The Agilent X-Series Analyzers use three licensing types: Fixed Perpetual, 
Transportable Perpetual, and Trial. These licensing types are available on all existing 
measurement applications except the Spectrum Analyzer Measurement Application 
(N9060A), which requires a fixed perpetual license and the Remote Language 
Compatibility Application (N9061A), which does not support transportable licenses. 
Fixed Perpetual licenses are also required to enable hardware options.

A license key is instrument model and serial number dependent. You can only install the 
a license key on the specific instrument for which it was created.

Fixed perpetual

Fixed Perpetual licenses are the traditional license type (Fixed) with the same duration 
(Perpetual) that have been available for all features since the MXA and EXA 
introductions. Fixed Perpetual licenses are identified by the “F” in the second character 
and “P” in the third character of the option designator:

Example: N9068A-2FP

A license key is instrument model and serial number dependent. You can only install the 
license key on the specific instrument for which it was created.

Transportable perpetual 

Transportable Perpetual licenses are an optional license type offering deployment 
duration which is not fixed to a specific instrument model and serial number. 
Transportable Perpetual licenses are identified in the product structure by a “T” in the 
second character and “P” in the third character of the option designator:

Example: N9051A-1TP

Additionally transports are allowed between instrument types as well. So a measurement 
application license can be transported from an MXA to an EXA or conversely, or 
between instruments of the same type, MXA or EXA.

Transportable Perpetual licenses require a connection to the Agilent server only for 
managing the check-in/out of the license. The Agilent licensing server also provides for 
storage of unused licenses which have been transported off instruments but are awaiting 
assignment to new instruments. The server will limit the number of transports per 30 day 
period per application license to 10.

Unlike Fixed Perpetual licenses which are pre-installed at the factory with new 
instrument purchases, Transportable Perpetual licenses require redemption and 
installation of the license before the first use. This allows the user to determine on which 
instrument to initially install the application license.
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Agilent recommends that instruments be at the same instrument software release to 
ensure the latest code is available on each instrument so that the user experience is 
identical between instruments. This is particularly important when transporting the 
license for a newly-released application which may only be available in the latest 
software release.

Trial licenses

Trial licenses are available so that you may try applications before you buy the full 
applications. These licenses are time limited for a 14 day period, and are restricted to one 
trial for an individual application per instrument. The restriction is enforced through the 
license redemption process of the Agilent Software Licensing (ASL) system.

Trial licenses are only available for measurement applications and not available for 
enabling hardware capability (N9010A or N9020A options).

Trial licenses are not installed in the factory and no entitlement certificates are created 
for distribution with new instrument shipments. Trial licenses are not available for order, 
but are available from the Agilent Web site after completing a brief registration:

http://www.agilent.com/find/xseries_trial

Trial Licenses are identified by the license designator “-TRL”.

Example: N9071A-TRL

If a product has multiple tiers (levels of functionality), the –TRL license enables all tiers 
for the duration of the license. If you have a base tier and want a trial license for a higher 
tier, you can install the –TRL license. When the duration expires the entitlement is 
reverted back to the base tier.
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Licensing New Measurement Application Software - After Initial 
Purchase

Additional measurement application software can be ordered after your initial purchase 
of the signal analyzer. Software upgrades are provided in a kit that includes an option 
based Entitlement Certificate, a license agreement, and a USB storage device. The 
licenses are downloaded from the license Web site onto the storage device so they can be 
loaded into the instrument.

If you do not want to wait for your upgrade kit to arrive, licenses can be installed using 
any available USB storage device. If you choose to do this, we recommend that the latest 
version of the instrument software be installed. This ensures that the measurement 
application being licensed and activated is installed and is the most current version.

The latest revision of the software may be downloaded from:

 http://www.agilent.com/find/exa_software

 http://www.agilent.com/find/mxa_software

A license key is usually for one instrument model and serial number combination. The 
license key will only install itself on that instrument.

Installation procedure over USB

No calibration is required after a measurement application 
installation.

Step Action Notes

1 Redeem the Option 
Upgrade Entitlement 
Certificate

• Follow the instructions on the Certificate After redeeming your Option Upgrade 
Entitlement Certificate you will receive 
an e-mail with an attached License File.

2 Save the license file • Save the .lic file to the root directory of a 
USB storage device

3 Load the license file • Connect the USB storage device to one of 
the signal analyzer USB ports.

Windows will detect the new hardware 
and may display the configuration menu. 
The signal analyzer will automatically 
load the license file. (This may take a 
few minutes) Upon completion, the 
Agilent License Manager will display a 
“Successful License Installation” 
message.

Alternatively the license file can be manually installed over USB or LAN by placing the 
license file in the following folder on the signal analyzer.

C:\Program Files\Agilent\licensing
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4 Verify installation a Cycle the power on the signal analyzer.
b Press System, Show, System.
c Verify that the new application appears in 

the list.

The application will not be available for 
use until after the power has been cycled.

This displays the list of installed 
applications.
If you require further assistance, please 
contact the Agilent support team.
Online assistance: 
http://www.agilent.com/find/assist
If you do not have access to the Internet, 
contact your local Agilent Technologies 
Sales and Service Office, or if in the 
United States, call 1-800-829-4444.

Step Action Notes
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Windows Configuration

The Windows settings have been optimized for the best measurement performance. Any 
modifications to these settings may degrade instrument performance and measurement 
speed. In general, most Windows System settings (typically set through the Windows 
Control Panel) should not be modified. Those that can be safely modified are listed 
below.

Settings that can be changed

You may change the following Windows settings or administrative tasks (available from 
the Windows Control Panel) to select your personal preferences. 

To recover from problems caused by changing Windows systems settings, 
you may have to reinstall the Windows system and instrument application 
using the Agilent Recovery process.

Before changing any Windows System settings, exit the instrument 
application. 

You may use 
this feature

To do this... 

Configure Microsoft Automatic Updates.

Install and configure an Anti Virus program.

Setup new Instrument user accounts.

  Do not delete or modify the “Agilent-Only” user 
account.

Add the Instrument to a network.
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Settings that must not be changed

Avoid changing any settings in this section. Changes to the following settings may 
degrade instrument performance, screen displays, and measurement speed.

Install and configure a printer.

Set the time and date.

Modify System Properties, Advanced Tab settings of Performance, Adjust 
for Best Performance. Leave all other settings unchanged.

You may use 
this feature

To do this... 

Do NOT use this 
feature

To do this... 

Do not change Power Options. (Power Scheme, Power Button, 
Hibernate)

Do not modify System Properties, Hardware Tab settings (Device 
Manager, Drivers).

Do not modify System Properties, Advanced Tab settings (Performance 
(except Adjust for Best Performance), User Profiles, Startup and 
Recovery, Environment Variables, Error Reporting)

Do not remove installed Fonts.

Do not change the following Display Settings:

• Screen Saver settings
• The screen resolution, 1024 x 768
• DPI setting from Normal size (96 DPI)
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In addition, DO NOT:

• Add, delete, or modify hard-disk drive partitions.

• Delete or modify Agilent registry entries.

• Change the contents of any directories containing the name “Agilent”

• Stop these services:

— The MSSQL$CDF service or uninstall the “Microsoft SQL Server Desktop 
Engine”

— The IIS server or tamper with any virtual directories (or their contents) that came 
configured with the instrument.

• Uninstall these libraries, interfaces, or programs:

— The Agilent I/O Libraries
— The .NET Framework or any Hotfixes or Service Packs for the .NET Framework
— The “Microsoft Visual J# .NET Redistributable Package 1.1"
— Programs that begin with “Agilent”
— The Adobe Acrobat Reader

• Modify

— The Agilent I/O Library “GPIB27”, “GPIB28” interfaces shown as configured 
Instrument I/O in the Agilent Connection Expert or I/O Config.

Do not change the Regional Options tab settings (Standards and 
formats, or Location).

Do not change the Language tab settings (Text services and input 
languages).

Do not delete or modify the “AgilentOnly” user account.

Do NOT use this 
feature

To do this... 
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Configuring Printers

Printers are configured using the Microsoft Windows Control Panel. It is easily accessed 
from the Windows Start menu or from under the front panel System key. This setup 
process is most easily done using a USB mouse and an external keyboard. If you do not 
have a mouse it can be done using front-panel keys. See “Navigating Windows Without 
a Mouse" on page 64.

When setting up a new printer, you may need to load the printer driver (unless you are 
using a network printer that your IT department has set up to include the driver). The 
manufacturer of the printer supplies the driver software and process. That may require 
that you attach an external USB disk drive. An alternative is to connect the instrument to 
the LAN and download the driver from the printer manufacturer’s internet site.
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Configuring LAN

Hostname

The Computer Name, or hostname, is pre-configured from the factory. It must be a 
unique name so that it does not conflict with other equipment on your LAN. The 
pre-configured Computer Name is A-N90yyA-xxxxx, where xxxxx is the last 5 digits of 
the instrument’s serial number and yy is 20 for an MXA or 10 for an EXA.

To change the Computer Name consult the Microsoft Windows XP Help and Support 
Center.

IP Address & Gateway

The instrument is pre-configured to obtain an IP Address using DHCP. The IP Address 
and Gateway can be changed. Consult the Microsoft Windows XP Help and Support 
Center to configure the LAN.
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Windows Security

Microsoft recommends the following to ensure the instrument's Windows XP operating 
system is protected:

• Use an internet firewall.

• Get the latest critical Windows updates.

• Use up-to-date antivirus software.

To check the status or make changes in the security settings for your instrument, open the 
Windows Security Center, click Start, Control Panel, and then click Security Center.

The window may look slightly different on your instrument.
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Windows Firewall

The instrument is shipped with the Windows Firewall enabled.

Windows Firewall Exceptions for programs and ports have been added to allow proper 
operation of the instrument over a network. Modifying these settings may cause the 
instrument to not operate properly.

Automatic updates

The default instrument setting is to automatically check for critical Windows Updates 
and notify you, if the instrument has internet access.

You can change the configuration of the Microsoft Automatic Updates to not notify you 
of updates.Then you can manually update Windows by accessing Internet Explorer and 
from the Tools menu select Windows Update.

The window may look slightly different on your instrument.
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Virus protection

There is no antivirus software included with your instrument. Antivirus application 
software has been tested to be compatible with the instrument. See the section on “3rd 
party software verified by Agilent" on page 39 for anti-virus software that has been 
tested by Agilent.

Be aware that downloading and installing Windows Updates can be 
network and CPU usage intensive (impacting the instrument performance), 
and some Windows Updates automatically reboot the instrument. It is 
recommended that Windows Updates be performed when the instrument is 
not in normal use.

Having antivirus software installed may have a slight impact on the 
instrument performance.
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Spyware protection

There is no anti-spyware software installed on the instrument. This should not be a 
problem if you do not use the instrument for a lot of internet browsing. Having spyware 
in the instrument could have an impact on the instrument performance.
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System Maintenance

Backup

It is recommended that you have a regular backup strategy. Your IT department may 
already have a backup strategy in place which is suitable for the instrument and its data. 
Using the Agilent Recovery system in conjunction with a regular backup strategy should 
allow full recovery of the instrument data.

Windows XP has a Backup utility that you can use to archive files and folders in case of 
a hard disk drive failure. See the Microsoft Windows XP Help and Support Center for 
more information on this utility. You can also use third party backup utilities. However, 
you must ensure that this third party software is compatible with the instrument's system 
software. See “Customer Installation of Software" on page 39 for more information.

When performing backups, we recommend that you backup the data to an external 
storage device connected to the network or one of the instrument's USB connectors. 
Also, you should perform backups at times when the instrument is not being used for 
normal operations as it may impact the instrument's overall performance.

System restore

Windows XP contains the capability to restore the system to a previous point in time. 
System Restore is enabled with default settings as provided by Microsoft. However, 
System Restore is not 100% successful. Therefore, it is not the recommended method to 
backup the instrument. System Restore has not been tested to verify successful restoring.

Disk defragmenting

Over time the instrument’s hard disk becomes fragmented. Windows XP has a Disk 
Defragmenter utility that you can use to defragment the hard disk. See the Microsoft 
Windows XP Help and Support Center for more information on this utility. 

Running Disk Defragmenter should be performed when the measurement 
application is not running. Measurement throughput is significantly 
impacted while disk defragmentation is in process.
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USB Connections

All of the USB ports are compatible with the USB 2.0 and 1.1 specification. The two 
USB ports on the front panel (see graphic below) and four of the USB ports on the rear 
panel are USB Series “A” ports. These are ports to which you can connect USB mass 
storage devices and printers. The instrument USB Host support includes the standard 
Microsoft Windows XP USB class drivers for human interface, mass storage, printing, 
scanning, and imaging devices. A complete up-to-date list of the Windows XP USB 
class driver support is available on the Microsoft website.

http://www.microsoft.com/whdc/system/bus/usb/USBFAQ_intro.mspx

The square USB port (see graphic below) on the rear panel is a USB Series “B” port and 
is used for controlling the instrument over USB. Information to help you program your 
instrument is documented in the N9060A User's Guide. The instrument USB device 
driver included in the instrument software supports the test and measurement industry 
standard USBTMC-USB488 device class. 

In addition, the Agilent IO Libraries CD that was included with your instrument contains 
USB Host drivers that allow control of other instruments connected to the USB bus.

USB

USB USB Series B
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Agilent Technologies does not support or warrant correct instrument operation if 
additional USB drivers from third parties are installed in the instrument. It is possible 
that additional drivers could break the normal USB operation. If USB operation is 
broken, recovery would require reinstalling the instrument application using the hard 
drive recovery process. 

Hard Drive Partitioning and Use

The drive is partitioned into 3 sections: C:, D: and E:

• The C: partition contains the Windows XP operating system and software installed 
by Agilent. This is an Open System which means you can install additional software, 
and these should be installed on the C: drive. However, only a limited set of software 
applications are tested for use with the Agilent measurement software. The 
installation and/or use of other software is not warranted, and could interfere with the 
operation of the measurement software. If instrument repair is ever needed, the 
Agilent version of the C: drive is the only part of the instrument software that is 
restored by the Agilent Recovery process. You must reload any other software that 
you have added in the instrument.

• The D: partition is reserved for data storage. The User Accounts that are configured 
by Agilent have their My Documents folder mapped to the D: drive. This is for the 
convenience of backing-up the measurement data. You should always back-up the 
data on the D: drive to an external device. This allows you to restore the data if you 
ever need to replace the hard drive.

• The E: partition is reserved for Agilent’s use. The primary use of the E: drive is for 
housing the Calibration and Alignment data. Do not change or overwrite the files on 
this drive. This could cause your instrument to not meet specifications, or even to 
stop functioning correctly. Do not use this drive for data storage. It is also 
recommended that you back up the contents of this drive by using the factory 
calibration data backup utility.
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Backing-up the factory calibration data

To back-up the factory calibration data you will need a USB mouse and storage device 
and follow the step below. 

Step Notes

1 Insert the mouse in one of the 
instrument USB ports

2 Insert the USB memory device in one 
of the instrument USB ports.

3 Press System, Alignments, Backup or 
Restore Align Data...

The Alignment Data Wizard will appear:

4 Follow the on screen instructions to 
backup the calibration data to the USB 
drive and save the file.
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Hard Drive Recovery Process

The Agilent Recovery System can be used to repair errors on the instrument's C: drive 
partition, or to restore the original factory configuration of the system software. The 
Agilent Recovery System is stored in a separate hidden hard disk drive partition.

Repairing errors on the hard disk drive may result in loss of data or files. If you need 
more information about the Windows “chkdsk” error repair process, see the chkdsk 
documentation in the Microsoft Windows XP Help and Support Center.

Restoring the original factory system software does not restore any of the following 
items:

• Windows system configurations that were made after the instrument was shipped 
from the factory. For example, Windows and Service Pack updates, user accounts, 
and windows configuration settings. After an Agilent Recovery, these configurations 
need to be redone.

• Additional software that was installed after the instrument was shipped from the 
factory. After an Agilent Recovery, that software needs to be re-installed.

• Any data or programs saved on the D: or E: drives.

• Any upgrades that were made to the Agilent measurement application software.

It is recommended that routine backups of the instrument information be performed to 
keep current archives of the instrument information. This allows a full recovery of the 
instrument information after the instrument recovery system operations are performed.   
See “Backup" on page 55 for more details.

It is recommended that you use a regular back up strategy. Your IT 
department may already have a back up strategy in place which is suitable 
for the instrument and its data. See “System Maintenance" on page 55. 
Using the Agilent Recovery System in conjunction with a regular back up 
strategy should allow you to fully recover the instrument software and data.
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Using the instrument recovery system

Step Notes

1 Make sure the instrument is turned off.

2 Turn on the instrument. After the Agilent Technologies screen is 
displayed,

this screen is displayed for five seconds.

3 Press the down arrow key to move the 
highlight to Agilent Recovery System, 
then press Enter.

4 When the Agilent Recovery System has 
booted, follow the on-screen instructions 
to recover the image of the C: drive.

• Press 2, then press Enter to select the 
recovery.

• Press 1, then press Enter to continue.
• Press 1, then Enter to confirm.

 
It may take up to 25 minutes for this process to 
complete

After exiting the Agilent Recovery System, the instrument reboots. If the original factory 
instrument system has been restored, the instrument re-executes the following 
process:“Turning on the Analyzer the First Time" on page 12 
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Configuring recovery prompt timing

You can configure the time at which the instrument power-up process waits for the 
selection of the recovery process by performing the following steps: 

Additional recovery steps may be required to fully recover the 
system to a more current working state. This could involve restoring 
your own backups of the instrument configuration, including 
re-installing applications, data, and performing system 
customizations.

Step Notes

1 Right-click My Computer, and click 
Properties.

This accesses the System Properties tabbed 
page.

2 Click the Advanced tab.

3 In the Startup and Recovery section, 
click Settings.

4 Under the System Startup section:
•  you can either clear the Time to 

display a list of operating 
systems check box, 
or,

• select the Time to display 
recovery option 
when needed check box and 
change the seconds to 
delay for it

You must be logged in as an administrator to change these settings. See 
“User Accounts" on page 40 for more information.
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Agilent X-Series Signal Analyzers
Getting Started Guide
4
Using Microsoft Windows XP

“Navigating Windows Without a Mouse" on page 64

“Remote Desktop: Using the X-Series Signal Analyzers Remotely" on page 68

“Embedded Web Server: Using the X-Series Signal Analyzers Remotely" on page 82

“Capturing/Printing Displays and Windows" on page 93

“Windows Shortcuts and Miscellaneous Tasks" on page 94

The capabilities described in this section are Microsoft Windows XP 
features. The discussion provided here gives some guidelines for using the 
capabilities with the instrument. You need to refer to the Windows XP help 
documentation for more information. Your version of Windows may not 
match these instructions exactly.

You need an external keyboard and mouse to fully use these features.
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Navigating Windows Without a Mouse

Key Presses Actions

Esc Exits/closes a Windows dialog box (does not exit an Application 
window)

Enter Does the current "default action". If a menu item or a button is currently 
highlighted, then the Enter key activates that menu item or button.

Alt Moves focus/control to the pull down menus bar in the active Window

Right Arrow In pull-down menu: opens the next menu to the right, or opens a 
submenu

In a dialog box: selects an option button

Left Arrow In pull-down menu: opens the next menu to the left, or opens a submenu

In dialog box: selects an option button

Up Arrow In pull-down menu: Moves to next selection up in the menu

In dialog box: selects an option button

Down Arrow In pull-down menu: Moves to next selection down in the menu

In dialog box: selects an option button

Tab In dialog box: moves to the next/previous field

Del Deletes the currently selected item

Alt + Tab Switches between the next/previous Application

Alt + Enter Shows the Properties of the currently selected item

Alt + Esc Cycles through items in the order that they had been opened

Backspace In My Computer or Windows Explorer: move up one level

In Internet Explorer: works like the BACK arrow key

Ctrl + Left arrow Moves to the left one word at a time

Ctrl + Right arrow Moves to the right one word at a time

Ctrl + Tab In dialog box: moves to the next/previous Tab location

Alt + Space Opens the window control menu for the currently active window, 
allowing you to minimize, maximize, move and restore (size) the 
window

Ctrl + Esc Opens the Windows Start Menu

Ctrl + Alt + Delete Opens the Windows Task Manager
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Using the interactive Help system without a mouse

To open the Help window for any menu Choose the desired menu, then press the front panel 
green Help key.

To toggle focus between the Navigation and topic 
panes:

Press the Next Window 
key

In the navigation pane In the topic pane

To scroll up or down the topic list:
Press the Up or Down Arrow key.

To scroll up or down:
Press the Up or Down Arrow 
key.

To expand or collapse the tree for the 
selected topic:
Press the Right or Left Arrow key.

To go to the next 
or previous page:
Use the Tab keys to 
select the Right or 
Left pointer button (in 
the Topic Pane)
Press Enter.

To display the selected topic:
Press the Enter key.

To scroll horizontally
or vertically:
Press Ctrl+Left, Right, Up, or 
Down Arrow keys.

To go back or forward:
Press the 
Alt+Left or Right 
Arrow key.

To switch tabs:
Press Ctrl+Tab keys.

To close the Help window:
Press the Cancel (Esc) key.

 

 

Navigation Tabs Navigation
Pane

Topic
Pane Window

Help

Softkeys remain

softkey to get 
Help for that key)

visible (press a
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Navigating Acrobat (PDF) without a mouse

When you open an Acrobat (PDF) document, it is displayed in the Adobe Reader Window, which appears 
as shown below.

In the navigation pane In the document pane

To go to next or previous 
Bookmark:
Press the Up or Down Arrow key.

To scroll up or down:
Press the Up or
Down Arrow key.

To expand or collapse the selected 
Bookmark:
Press the Right or Left Arrow key.

To zoom in or out:
Press the 
Alt+Left or Right 
Arrow key.

To display the content of the selected 
Bookmark:
Press the Enter key.

To Zoom to:

a) Fit page in window:  Press Ctrl + 0 keys

b) Page actual size  Press Ctrl + 1 keys

c) Fit page to width  Press Ctrl + 2 keys

c) Fit visible object  Press Ctrl + 3 keys

To switch tabs:
Press Ctrl+Tab keys.

Navigation
Pane

Document
Pane

Navigation
Pane
66 Getting Started Guide



Using Microsoft Windows XP 4
To select Thumbnails, 
and Display pages 
(from Pages Tab): 
Press the Left/Right/Up/Down 
keys to navigate, then press 
Enter to display a selected Page.

To go to a specific page:
Press the Next Window key to open the 
Go to Page dialog, then enter the page 
number using the Numeric keypad, 
and press Enter.

To print all or part of a document:
Press the Print key to open the Adobe Reader Print Dialog, 
then use the Tab keys to set options, and select OK to print.

To Exit Adobe Reader:
Press Alt + Select keys to open the File menu.
Use the Down Arrow key to select Exit, then press Enter.

In the navigation pane In the document pane
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Remote Desktop: Using the X-Series Signal Analyzers Remotely

Windows Remote Desktop is recommended for remote control of the instrument. It 
offers fully-interactive control, that is almost identical to direct face-to-face control of 
the instrument. You can also remotely control the instrument using the Embedded Web 
Server interface. The Embedded Web Server functionality provides a communications 
method that does not require login to the instrument. However, due to its slower response 
time, it is only recommended for setup and data exchanges that do not involve 
instrument control.

You need an external keyboard and mouse to fully use this functionality.

Overview of Remote Desktop operation

Using the Remote Desktop functionality of the instrument allows you to control and 
interact with the instrument from a remote computer, as though you were sitting in front 
of the instrument.

When you have configured the instrument for remote connectivity, and configured a 
separate computer to act as a Remote Desktop Host, you can send commands to the 
instrument from the remote computer, and you can see the instrument display on the 
screen of the remote computer.

This section provides full details of how to set up the instrument for remote connectivity, 
and also how to set up a computer running any 32-bit version of Microsoft Windows as a 
Remote Desktop Host.

Setting up Remote Desktop operation

Setting up the instrument

Before the instrument can be controlled through a Remote Desktop Connection, it must 
be set up to allow connection from a remote computer. 

The Remote Desktop functionality is a Microsoft Windows XP capability. 
The following discussion provides some guidelines for using this 
capability with the instrument. You need to refer to the Windows XP help 
documentation for more information. As Windows evolves, these 
instructions may no longer be exact.
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 Basic setup for remote desktop operation

Setting up a remote desktop connection

Step Notes

1 To perform this operation successfully, 
you must have Administrator level access 
to the instrument.

2 On the instrument, open the Windows 
Control Panel.
• From the instrument application, press 

System, Control Panel, 
or, 

• From the Windows Desktop, click 
Start, Control Panel.

3 Select System.
• From the Control Panel Category View, 

click Performance and Maintenance, 
then click System. 
or,

• From the Control Panel Classic View, 
double-click System.

4 Click the Remote tab. A Warning Message appears, informing you 
that it may be necessary to configure your 
internet connection sharing or personal firewall 
to permit Remote Desktop connections. The 
details of such configuration are beyond the 
scope of this document.

5 Click the Allow users to connect 
remotely to this computer checkbox.

6 To add users, click Select Remote Users, 
Add.
• Follow the on screen instructions.
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Setting up the remote computer

The procedure depends on whether the Remote Computer to be set up is running 
Windows XP, or another version of Microsoft Windows.

Remote computer running Windows XP  Windows XP includes the Remote Desktop 
Connectivity Client software, so no additional setup is required.

Remote computer running another version of Windows  You can use any 32-bit 
version of Windows (Windows 95, 98, ME, NT4, or 2000) to install and run the Client 
software for Remote Desktop Connectivity. However, you need to have available a 
Windows XP installation CD-ROM, because that contains the Client software.

How to locate the computer name of the instrument

To connect a remote computer to the instrument, you need to know its Computer Name. 
The Computer Name can be displayed as follows:

The following instructions relate to software provided by Microsoft 
Corporation. Agilent offers no warranty regarding the operation of such 
software. The procedure described here may be changed by Microsoft at 
some future time.

Installing the Client software

Step Notes

1 When the Welcome Screen appears, click 
Perform additional tasks

2 From the What do you want to do? screen, 
click Set up Remote Desktop Connection.

The Remote Desktop Connection InstallShield 
Wizard appears. 

3 Click Next.  Follow the on screen instructions provided by 
the Wizard.

4 To access the installed software, click 
Start > All Programs > Accessories > 
Communications > Remote Desktop 
Connection.

Locating the name from the Agilent application

Step Notes

• On the instrument front panel, press 
System, Show, System.

A page listing various parameters appears.The 
instrument’s computer name is shown in the 
list next to the title Computer Name. 
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Locating the name from the Windows desktop (with a mouse):

Step Notes

1 Click Start, Control Panel. If the Control Panel window appears in 
Category View, click Performance and 
Maintenance, then System, to display the 
System Properties dialog. If the Control Panel 
appears in Classic View, double-click System 
to display the System Properties dialog.

2 Click the Computer Name tab of the System 
Properties dialog.

3 To close the System Properties dialog, click 
Cancel.

Locating the name from the Windows desktop (without a mouse):

Step Notes

1 Press Ctrl+Esc to display the Windows 
Start menu. 

2 Use the Up Arrow or Down Arrow keys to 
select the Control Panel item.

3  Press Enter to open the Control Panel 
dialog.

4 In Category View, press Tab to select 
Performance and Maintenance, then press 
the Tab again to select System,
or, 
in Classic View, press the Tab and the 
Arrow keys to select System, then press 
Enter.

The System Properties dialog is displayed. 

5 Press Ctrl+Tab until the Computer Name tab 
is selected. 

The Computer Name is displayed under Full 
computer name.

6 Press Tab to select the Cancel button, then 
press Enter.

7 To close the Control Panel dialog:
• Press Alt+Select to open the drop-down 
File menu

• Press the Down Arrow until the Close 
menu item is selected

• Press Enter to close the Control Panel 
dialog.
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Running a Remote Desktop session

Initializing a Remote Desktop session

After setting up both the instrument and the remote computer for Remote Desktop 
Connectivity, as described in “Setting up Remote Desktop operation" on page 68, you 
are ready to start a Remote Desktop session.

The instrument display appears on the screen of the remote computer. Because the 
instrument front-panel keys are not available when using the instrument remotely, three 
alternative methods are available to perform the functions of the front-panel keys, as 
detailed in the following sections: 

To initialize a Remote Desktop Session, you need to know the Computer 
Name of the instrument. This information can be shown on the instrument 
display by following the procedure in the section “How to locate the 
computer name of the instrument" on page 70.

Starting a session

Step Notes

1 Click Start > All Programs > Accessories > 
Communications > Remote Desktop 
Connection.

A Remote Desktop Connection dialog 
appears:

2 Enter the computer name of the instrument.

3 Click Connect. A login dialog box appears.

4 Enter the login account name and 
password.

The default account name is Instrument and 
the default password is measure4u, but these 
parameters may be changed by instrument 
users.

 Only the current User or an Administrator can remotely log into the 
instrument. To see who the current user of the instrument is, press 
Ctrl+Esc on the instrument until you can view the current user name on 
the Start menu. If no one is currently logged into the instrument, any valid 
instrument user can remotely log in.
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• “Accessing menus for Remote Desktop operation" on page 76

• “Keycode commands for Remote Desktop operation" on page 77

• “The Virtual Front Panel" on page 81

Setting Remote Desktop options

Step Notes

1 On the Remote Desktop 
Connection menu, click Options.

The Options dialog has several tabs. Generally, the 
default settings are correct. 

2 Under the General tab, ensure that 
the Computer name, User name 
and Domain name are set correctly. 

You may choose to enter the password and save it for 
future sessions, by checking the Save my password box.
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3 Click the Display tab.
• Under Remote desktop size, you 

may select the size of the 
window in which the instrument 
display appears. Do not select 
any size smaller than 1024 x 768 
pixels. Selecting a remote 
desktop size smaller than 1024 x 
768 results in the instrument 
display not being fully visible. 
In such circumstances, scroll 
bars do not appear, so portions 
of the display are not accessible.

• Under Colors, you may select 
any setting that uses 15 bits or 
more. Selecting a color setting 
that uses less than 15 bits results 
in dithering and incorrect color 
rendition of the remote desktop 
window.

4 Click the Local Resources tab.
• Selecting the Disk Drives 

checkbox enables you to transfer 
data between the remote desktop 
and the local PC. 
To transfer data, click Start on 
the task bar of the remote 
computer, then click My 
Computer. Explorer opens on 
the remote computer and 
displays the drives of both the 
remote computer and the local 
computer. You can now copy 
and paste between the two disk 
drives.

Step Notes
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5 Click the Experience tab. To Optimize the performance of the Remote Desktop 
session, choose the appropriate connection format from 
the drop-down list.

Step Notes
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Accessing menus for Remote Desktop operation

Using the mouse, right-click the application display window to access the following 
remote desktop menus, which may be used as an alternative to the front-panel keys:.

The function of each selection in the menu is generally identical to that of the 
corresponding front-panel key. The following lists additional functionality:

Exit – Selecting this item closes the Application software.

Utility > Page Setup – Selecting this item opens a printer setup dialog.

Utility > Virtual Front Panel – Selecting this item opens the Virtual Front Panel 
window, as described in the Section “The Virtual Front Panel" on page 81.

The menus are also available when using the instrument directly, provided 
that a mouse or other pointing device is attached to it.
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Keycode commands for Remote Desktop operation

When using the instrument in remote desktop mode, the following combinations of 
remote keyboard keys can be used to perform the operation of the instrument front-panel 
keys.

Keycode commands

To initiate the following front-panel key: Press these keys on the remote computer 
keyboard:

AMPTD Y Scale Ctrl+Shift+A

Auto Couple Ctrl+Shift+C

Bk Sp Backspace

BW Ctrl+Alt+B

Cancel (Esc) Esc
Getting Started Guide 77



4 Using Microsoft Windows XP
Cont Ctrl+Alt+C

Ctrl Ctrl

Decrease Audio Volume the Volume Control slider

Del Delete

Down Arrow Down Arrow

Enter Enter (Return)

File Ctrl+F

FREQ Channel Ctrl+Shift+F

Full Screen Ctrl+Shift+B

Help F1

Increase Audio Volume the Volume Control slider

Input/Output Ctrl+Shift+O

Left Arrow Left Arrow

Marker Ctrl+Alt+K

Marker -> Ctrl+Alt+N

Marker Function Ctrl+Alt+F

Meas Ctrl+Alt+M

Meas Setup Ctrl+Alt+E

Menu (Alt) Alt

Mode Ctrl+Shift+M

Mode Preset Ctrl+M

Mode Setup Ctrl+Shift+E

Mute the Mute checkbox under the Volume Control

Next Window Ctrl+Shift+N

Peak Search Ctrl+Alt+P

Print Ctrl+P

Quick Save Ctrl+Q

Recall Ctrl+R

Restart Ctrl+Alt+R

Return Ctrl+Shift+R

Keycode commands

To initiate the following front-panel key: Press these keys on the remote computer 
keyboard:
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Right Arrow Right Arrow

Save Ctrl+S

Select Space Bar

Single Ctrl+Alt+S

Softkey 1 Ctrl+Shift+F1

Softkey 2 Ctrl+Shift+F2

Softkey 3 Ctrl+Shift+F3

Softkey 4 Ctrl+Shift+F4

Softkey 5 Ctrl+Shift+F5

Softkey 6 Ctrl+Shift+F6

Softkey 7 Ctrl+Shift+F7

Source Ctrl+Alt+U

SPAN X Scale Ctrl+Shift+S

Split Screen Ctrl+Shift+L

Sweep/Control Ctrl+Shift+W

System Ctrl+Shift+Y

Tab Tab

Trace/Detector Ctrl+Alt+T

Trigger Ctrl+Shift+T

Up Arrow Up Arrow

User Preset Ctrl+U

View/Display Ctrl+Shift+V

Zoom Ctrl+Shift+Z

1 1a

2 2a

3 3a

4 4a

5 5a

6 6a

Keycode commands

To initiate the following front-panel key: Press these keys on the remote computer 
keyboard:
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Ending a Remote Desktop session

There are two ways to disconnect the remote computer from the instrument, ending the 
session:

7 7a

8 8a

9 9a

– Use the – key to enter a negative value, as 
appropriatea

. (Decimal Point) . (Period)a

0 (Zero) 0 (Zero)a

a. For remote keyboards that feature a numeric keypad, use either the appropriate 
numeric keypad key or the main keypad key.

The effect of pressing Ctrl+Alt+Delete on the keyboard of the remote 
computer always applies to the remote computer, and not to the 
Instrument. Generally, the effect of pressing this key combination is to 
display the Windows Task Manager. Therefore, pressing this key 
combination on the remote computer does not allow you to reboot the 
Instrument.

Step Notes

1 Click the X, then click OK. For full-screen, the X appears at the top center 
of the window.

For non full-screen, the X appears in a red box 
at the right of the window’s title bar.

or

2 When the remote desktop is full screen, 
move the cursor to the bottom left of the 
window:
• Click Start, Disconnect.
• Click Disconnect.

You are asked to confirm that you want to 
disconnect.

Keycode commands

To initiate the following front-panel key: Press these keys on the remote computer 
keyboard:
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The Virtual Front Panel

The Virtual Front Panel is a software equivalent of the front-panel key set, which 
provides another alternate method for instrument control. It may be displayed in a 
separate window on the instrument (or remote desktop) display. 

Using the mouse, right-click the application display window, then select Utility > Virtual 
Front Panel. The Virtual Front Panel appears, as shown below:

When you click a button in the Virtual Front Panel, it performs the operation of the 
corresponding instrument front-panel key. The buttons at the left of the panel, named 
Key 1 through Key 7, perform the operation of the respective softkeys. The Rpg Up and 
Rpg Down keys perform the operation of the knob.

The Virtual Front Panel is also available when using the instrument 
directly, provided that a mouse or other pointing device is attached to it.
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Embedded Web Server: Using the X-Series Signal Analyzers Remotely

The instrument can be controlled using either the Embedded Web Server or Windows 
Remote Desktop. The Embedded Web Server is a good solution when you do not want to 
log into the instrument's user account. This allows you to view the display or control the 
instrument, without logging the current user off. Windows Remote Desktop must be 
used when the remote computer keyboard is needed as an input device (such as for 
editing filenames, or setting the title.) Also, Windows Remote Desktop generally has a 
faster response time.

Accessing the instrument through the Internet

It is possible to access and control the instrument through the Internet and World Wide 
Web, or a local internet, using the built-in Embedded Server functionality. This section 
provides details of how to use this functionality.

The instrument may also be accessed and controlled using the Windows Remote 
Desktop functionality (see the section “Remote Desktop: Using the X-Series Signal 
Analyzers Remotely" on page 68, for details).

The instrument Embedded Server capabilities are fully compliant with the LXI (LAN 
eXtensions for Instrumentation) standard. 

To gain access to the instrument from the LAN, you need to know its 
hostname (or IP Address). For details of how to locate this information 
using the instrument Display, see “How to locate the computer name of 
the instrument" on page 70.

Accessing the instrument

Step Notes

1 Enter a URL corresponding to the 
instrument hostname or IP Address.

  This functionality is only fully 
supported when using Internet 
Explorer.

In this example, the host name is “a-n9020a-10010”.

When the connection is 
made, the welcome 
page appears.
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2 Click Advanced information about 
this Web-Enabled MXA

This displays further settings and configuration 
information.

At the left side 
of the page are 
a set of tabs 
that provide 
access to 
configuration 
information for 
the instrument, 
plus the ability 
to control it 
through the 
web interface. 

Accessing the instrument

Step Notes
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Selecting the View and Modify Configuration tab

Step Notes

1 Click Verify and Modify 
Configuration.

This displays a web page, which shows the 
instrument’s currently-assigned IP address and other 
TCP/IP parameters.

2 Click on either of the Modify 
Configuration buttons.

A password entry dialog appears.

By default, this password is set at the factory as 
“agilent”. However, you may subsequently change the 
password. (Press System, I/O Config, Reset Web 
Password on the instrument front panel to change the 
password.)

When the correct password has been entered, the 
Modify Configuration web page appears.
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3 Enter new settings as required, then 
click Apply to cause the new settings 
to take effect. 

Before clicking Apply, you may use the Undo Changes 
button to revert all settings to their previous values. 

4 Use Start Identify and Stop Identify 
to enable and disable the LXI status 
indicator in the instrument.

  Tool tips are available for each of 
the configuration buttons on this 
page.

Selecting the View and Modify Configuration tab

Step Notes
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Accessing the Web Control SA tab

Selecting this tab lets you view, control and interact with the instrument through the web 
server.

Step Notes

1 Click Control A password entry dialog appears.

By default, this password is set at the factory as 
“agilent”. However, you may subsequently change the 
password. (Press System, I/O Config, Reset Web 
Password on the instrument front panel to change the 
password.)

When the correct password is entered, the instrument 
control web page appears.

  To view the instrument display, the 
instrument application must be 
running.

2 Click Display Front Panel Keys This brings up a virtual keyboard that can be used to 
control the instrument.
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Selecting the Get Data tab

Selecting the Get Data tab allows you to capture results from the instrument’s currently 
active measurement. Depending on the current measurement type, captured results 
consist of either Trace Data or Measurement Results.

The captured data is formatted as a Comma Separated Value (CSV) file, which may be 
saved on the client computer’s hard disk, or opened with a spreadsheet application such 
as Microsoft Excel, or imported into a database application such as Microsoft Access.

Step Notes

To capture data using the web server, the instrument application must be 
running.
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A typical Get Data web page display is shown below:

If the measurement currently running does not support the selected result type, the web 
page indicates this:

Selecting the Get Image tab

Selecting the Get Image tab captures a screen from the Instrument display.

The image is captured as a Portable Network Graphics (PNG) file, to the default file 
name Screen.png. The image file can be saved to the client computer hard disk, or 
copied to the Windows clipboard.

To capture a screen image using the web server, the Instrument 
Application must be running.
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A typical screen capture image appears as follows:
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Selecting the SCPI Telnet tab

Selecting the SCPI Telnet tab opens a Telnet session between the instrument and the 
client computer. The instrument TCP/IP port used for SCPI access is 5023.

To run a SCPI Telnet session, the instrument application must be running.

Step Notes

1 Click SCPI Telnet A password entry dialog appears.

By default, this password is set at the factory as 
“agilent”. However, you may subsequently change the 
password. (Press System, I/O Config, Reset Web 
Password on the instrument front panel to change the 
password.)

When the correct password is entered, the connection 
window appears.

2 Click SCPI Telnet Session The telnet command line interface appears.
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SCPI commands and 
queries may be entered 
using the command line 
interface. 

3 To exit the telnet session, press 
Ctrl+] on the client computer 
keyboard.

Step Notes
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Selecting the Help tab

Selecting the Help tab displays basic help information about each of the other tabs, plus 
performance tips, as shown:
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Capturing/Printing Displays and Windows

You need an external keyboard and mouse to use this feature.

Save the desktop: 

Save the current active window: 

Step Notes

1 Press Print Screen on the external 
keyboard

This captures the desktop and saves it on the Windows 
clipboard.

2 Open a graphics software program 
like Microsoft Paint

3 Paste the clipboard contents into 
the program

The keyboard shortcut Ctrl + v will paste the contents of 
the clipboard.

4 Save the image in a file

Step Notes

1 Click on the window you want to 
capture

This activates the window.

2 Press Alt + Print Screen on the 
external keyboard

This captures the window and saves it on the Windows 
clipboard.

3 Open a graphics software program 
like Microsoft Paint

4 Paste the clipboard contents into 
the program.

The keyboard shortcut Ctrl + v will paste the contents of 
the clipboard.

5 Save the image in a file.
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Windows Shortcuts and Miscellaneous Tasks

This section provides a list of windows shortcuts (key combinations) that are useful 
when you operate the instrument without an attached mouse and keyboard. (See also 
“Navigating Windows Without a Mouse" on page 64.) Although these shortcuts are 
available in any Windows XP system, they are not commonly used when a mouse and 
keyboard are attached.

Windows shortcuts (key combinations)

You can use the following combinations of front panel keys to perform basic windows 
tasks when using the instrument without an attached mouse and keyboard.

Windows shortcut key combinations

To do the following: Press:

Display the Windows Start Menu Ctrl+Esc

Cycle through all open applications Alt+Tab

Select the first menu of a menu bar Alt

Move through menu headings Left Arrow, Right Arrow

Open (drop down) a menu Down Arrow

Move through items in an expanded menu Up Arrow, Down Arrow

Close the current menu selection Esc

Cancel the current menu bar selection Alt

Open an application’s control menu (usually the left-most 
menu on the menu bar, starting with File)

Alt+Select

In a dialog: move between tabs Ctrl+Tab

In a dialog: move forward through dialog box items Tab

In a dialog: move backward through dialog box items Shift+Tab

In a dialog: open a list box Alt+Down Arrow

In a dialog list box or check box: select or deselect items Select

In a dialog list box or check box: select or deselect one 
item at a time

Shift+Up Arrow, Shift+Down Arrow

In My Computer, expand a selected folder Enter

In My Computer, open a folder one level up from the 
current folder

Bk Sp
94 Getting Started Guide



Using Microsoft Windows XP 4
Navigating an application menu without a mouse or keyboard

This example uses Microsoft Excel, but you can use a similar sequence of operations to 
select and execute any menu item of any application.

To select and execute the item Sheet > Rename option from the Format menu in the menu 
bar shown below,

perform the following operations:

Windows taskbar auto-hide feature

The Windows taskbar should always be in the auto-hide mode when using the instrument 
application. If the taskbar is not set to auto-hide, the lower part of the instrument display 
is obscured by the taskbar. 

Step Notes

1 Press Alt to select the File menu in the menu bar. The focus must be in the appropriate 
window.

2 Use the Right Arrow and Left Arrow keys to move 
horizontally to the Format menu.

3 Press the Down Arrow to expand the Format menu.

4 Use the Down Arrow and Up Arrow keys to move 
vertically to the Sheet menu item.

5 Press the Right Arrow key to expand the Sheet 
sub-menu.

The Rename sub-menu item appears 
already selected. If another item in 
the same sub-menu is required, use 
the Down Arrow and Up Arrow keys 
to move vertically to that item.

6 Press Enter to execute the selected action.
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If a mouse is attached to the instrument, and you move the mouse cursor to the bottom of 
the display (either deliberately or accidentally), the taskbar automatically appears. 
Provided that the taskbar is in auto-hide mode, you can make it disappear again by 
moving the mouse cursor away from the bottom of the screen.

If at any time the Windows taskbar is inadvertently set to the non-auto-hide mode, you 
can restore the auto-hide behavior by doing the following:

Restoring taskbar auto-hide mode

Step Notes

1 Click Start > Control Panel If not using a mouse, press Ctrl+Esc.

2  In Classic View, click Taskbar and Start 
Menu, 
or,
in Category View, click Appearance and 
Themes, Taskbar and Start Menu

If you are not using a mouse, use the shortcut 
key combinations specified in the Section 
“Windows shortcuts (key combinations)" on 
page 94 to make these selections.

3 Click the Taskbar tab The Taskbar and Start Menu Properties 
dialog appears.

4 Select the Auto-hide the taskbar check box If you are not using a mouse, press Tab 
repeatedly until the auto-hide option is 
selected, then press Select to toggle the check 
box state.
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Windows startup folder

All Windows XP systems include a special folder, called the Startup folder. If a program, 
or a shortcut to a program, is placed in the Startup folder (either by Windows itself, or by 
a third-party application, or by any user), that program automatically runs every time 
Windows is restarted. 

When your instrument is first configured by Agilent, shortcuts to the appropriate 
application software and supporting programs are placed in the Startup folder. The exact 
contents of the Startup folder depends on the options you purchased with your 
instrument. 

If you wish to view the contents of the Startup folder, do one of the following:

• Either click Start, All Programs, then select Startup, 
or,

• Click Start, My Computer, then navigate to the folder:
C:\Documents and Settings\All Users\Start Menu\Programs\Startup. 

Additional startup items may also appear in the corresponding startup folder for the user 
that is currently logged on. For example, the startup folder for the administrator user is 
C:\Documents and Settings\administrator\Start Menu\Programs\Startup.

5 Click OK. This applies the change and closes the dialog 
box.

Restoring taskbar auto-hide mode

Step Notes

Important You should never delete items that appear in the Startup folder, or move 
any item from the Startup folder to another folder. Deleting or moving any 
item in the Startup folder may cause applications not to start automatically 
when Windows is restarted, or may cause certain options to be 
unavailable when using the instrument.
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Agilent X-Series Signal Analyzers
Getting Started Guide
5
Troubleshooting

“Check the Basics" on page 100

“Problems with Microsoft Windows XP" on page 102

“Returning an Analyzer for Service" on page 103

No operator serviceable parts inside. Refer servicing to qualified personnel. 
To prevent electrical shock do not remove covers.
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Check the Basics

o Is there power at the receptacle? 

o Is the analyzer turned on? Check to see if the green LED beside the power switch is 
on. Also, listen for internal fan noise to determine if the analyzer cooling fans are 
running. 

o If other equipment, cables, and connectors are being used with your signal analyzer, 
make sure they are connected properly and operating correctly. 

o Is the Measurement Application running? If not, there is a software launch 
shortcut/icon on the desktop.

o Does the instrument application have the focus? (That is, is the blue window banner 
highlighted?) If not, move focus to the application with Alt-Tab.

o Review the measurement procedures being performed when the problem first 
appeared. Are all of the settings correct? 

o If the analyzer is not functioning as expected, return the analyzer to a known state by 
pressing Mode Preset.

o Is the measurement being performed, and the results that are expected, within the 
specifications and capabilities of the analyzer? Refer to the specifications guide for 
your analyzer. Technical manual pdf files are available in the instrument (C:\Program 
Files\Agilent\SignalAnalysis\Infrastructure\Help\files), on the documentations cd 
provided with the instrument, and on the Agilent website: 
http://www.agilent.com/find/mxa_manuals 
or 
http://www.agilent.com/find/exa_manuals

o If the analyzer is not communicating via the LAN connection, check for the presence 
of blinking yellow LEDs on the rear panel LAN connector. If the ACT LED is not 
blinking, check the LAN cable and LAN integrity.

o To meet specifications, the analyzer must be aligned. Either the Auto Align (On) 
feature must be selected (press System, Alignments, Auto Align, Normal), or the 
analyzer must be manually aligned. 

o Perform an Alignment. Press System, Alignments, Align Now, All. 

o If the previously performed alignments did not resolve the problem, press System, 
Alignments, Restore Align Defaults. Then press System, Alignments, Align Now, All.

Some analyzer settings are not affected by a Preset. If you wish to reset the 
analyzer settings, press System, Power On, Restore Power On Defaults.
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Troubleshooting 5
o Is the analyzer displaying an error message? If so, refer to the Instrument Messages 
Guide.

o Check if the external frequency reference is selected but not available. Verify that it is 
selected by pressing Input/Output, Freq Ref In. If External is selected, changing the 
setting to Sense allows the analyzer to sense the presence of an external reference and 
use it only if it is available. The frequency of the reference should be set correctly.

o If you are using a Windows program, other than the instrument application, you may 
notice it running slow. Place the instrument application in single 
sweep/measurement.

Tip You can get automatic electronic notification of new firmware releases and 
other product updates/information by subscribing to the Agilent 
Technologies Test & Measurement E-Mail Notification Service for your 
signal analyzer at http://agilent.com/find/notifyme
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Problems with Microsoft Windows XP

The Microsoft Windows XP operating system settings have been optimized for the best 
performance. Modification of these settings may degrade instrument performance and 
measurement speed. Those that can be safely modified are described in “Settings that 
can be changed" on page 46

The X-Series if Signal Analyzers operate in an open Windows environment, so you can 
install software on the instrument. However, installation of non-approved software may 
affect instrument performance. Agilent does not warrant the performance with 
non-approved software installed.
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Returning an Analyzer for Service

Calling Agilent Technologies 

Agilent Technologies has offices around the world to provide you with complete support 
for your analyzer. To obtain servicing information or to order replacement parts, contact 
the nearest Agilent Technologies office listed below. In any correspondence or telephone 
conversations, refer to your analyzer by its product number, full serial number, and 
software revision. 

Press System, Show, System, and the product number, serial number, and software 
revision information will be displayed on your analyzer screen. A serial number label is 
also attached to the rear panel of the analyzer.

Locations for Agilent Technologies

Read the Warranty 

The warranty for your analyzer is in the front of your Specifications Guide. Please read it 
and become familiar with its terms. 

If your analyzer is covered by a separate maintenance agreement, please be familiar with 
its terms. 

Service Options 

Agilent Technologies offers several optional maintenance plans to service your analyzer 
after the warranty has expired. Call your Agilent Technologies office for full details. 

If you want to service the analyzer yourself after the warranty expires, you can purchase 
the service documentation that provides all necessary test and maintenance information. 

You can order the service documentation, Option 0BW (assembly level troubleshooting 
information) through your Agilent Technologies office.

Online assistance: http://www.agilent.com/find/assist

United States
(tel) 1 800 829 4444
(fax) 1 800 829 4433

Latin America
(tel) (305) 269 7500
(fax) (305) 269 7599

New Zealand
(tel) 0 800 738 378
(fax) 64 4 495 8950

Canada
(tel) 1 877 894 4414
(fax) (905) 282-6495

Japan
(tel) (81) 426 56 7832
(fax) (81) 426 56 7840

Asia Pacific
(tel) (852) 3197 7777
(fax) (852) 2506 9284

Europe
(tel) (31 20) 547 2323
(fax) (31 20) 547 2390

Australia
(tel) 1 800 629 485
(fax) (61 3) 9210 5947
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5 Troubleshooting
Service Tag

When you are returning an analyzer to Agilent Technologies for service, fill out and 
attach one of the blue service tags provided at the end of this chapter. Please be as 
specific as possible about the problem. If you have recorded any error messages that 
appeared on the display, have completed a functional test, or have any other specific data 
on the performance of your analyzer, please include a copy of this information. An 
example of the tag is shown below.
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Packaging the Instrument

Use original packaging or comparable. It is best to pack the unit in the original factory 
packaging materials if they are available.

You can repackage the analyzer with commercially available materials, as follows:

Analyzer damage can result from using packaging materials other than 
those specified. Never use styrene pellets in any shape as packaging 
materials. They do not adequately cushion the equipment or prevent it from 
shifting in the carton. They cause equipment damage by generating static 
electricity and by lodging in the analyzer louvers, blocking airflow. 

Step Notes

1 Attach a completed service tag to 
the analyzer

2 Wrap the analyzer in antistatic 
plastic to reduce the possibility of 
damage caused by electrostatic 
discharge

3 Use a strong shipping container. The carton must be both large enough and strong 
enough to accommodate the analyzer. A 
double-walled, corrugated cardboard carton with 159 
kg (350 lb) bursting strength is adequate. Allow at 
least 3 to 4 inches on all sides of the analyzer for 
packing material. 

4 Surround the equipment with three 
to four inches of packing material 
and prevent the equipment from 
moving in the carton.

If packing foam is not available, the best alternative is 
plastic bubble-pak. This material looks like a plastic 
sheet filled with 1-1/4 inch air bubbles. Use the 
pink-colored bubble which reduces static electricity. 
Wrapping the equipment several times in this material 
should both protect the equipment and prevent it from 
moving in the carton. 

5 Seal the shipping container securely 
with strong nylon adhesive tape.

6 Mark the shipping container 
“FRAGILE, HANDLE WITH 
CARE” to assure careful handling. 

7 Retain copies of all shipping 
papers. 
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B
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boot wait time, 61

C
C drive usage, 57
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connectors, front panel, 28
contents of shipment, 10
Control Panel

taskbar, 95
Control Panel access, 49
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changed, 46

controlling Windows without a 
mouse, 64
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D
D drive data storage, 57
data storage, 57
date and time setting, 47
defragmenting your disk, 55
desktop saving, 93
Device Manager settings, Microsoft 

Windows, 47
Device USB port, 56
directories, Agilent, 48
disk defragmentation, 55
disk drive partitioning, 48
display capture, 88
display print, 93
display save, 93
Display settings, Microsoft Windows, 47
Domain Name, 73
drive C use, 57
drive D use, 57
drive partitioning, 48
drive recovery, 59
Drivers settings, Microsoft Windows, 47

E
electrostatic discharge (ESD)

protecting against, 25
Embedded Web Server

Get Data Page, 87
Get Data Tab, 87
Get Image Page, 88
Get Image Tab, 88
Help Page, 92
Help Tab, 92
SCPI Telnet Page, 90
SCPI Telnet Tab, 90
View & Modify Configuration 

Page, 84
View & Modify Configuration Tab, 84
Web Control SA Page, 86
Web Control SA Tab, 86

embedded web server, 82
Environment Variables settings, 

Microsoft Windows, 47
Error Reporting settings, Microsoft 

Windows, 47

F
file backup, 55
firewalls, 51, 52
fixing the hard disk, 60
font size, changing, 47
Fonts removal, Microsoft Windows, 47
front panel

connectors and keys, 28
keycode alternates, 77
popup menu alternative, 76
shortcut keys, 77
symbols, 36
virtual, 81

fuses, 23

G
gateway setting, 50
GPIB27 or GPIB28, 48

H
hard disk recovery process, 60
hard drive recovery, 59
Help

Embedded Web Server, 92
help navigation without a mouse, 64
Hibernate, Microsoft Windows, 47
Host USB ports, 56
hostname setting, 50

I
IIS server, 48
initialization with mouse, 12
initialization without mouse, 17
installing other software, 39
installing programs to drive C, 57
instrument drivers, USB, 56
instrument location, 11
Instrument logon, 40, 41
instrument recovery, 60
instrument repair tag, 104
instrument ventilation, 11
IP address setting, 50

K
key overview, 30
Keycode Commands

Windows, 94
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L
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administrator, 40
instrument, 40

M
menu keys, 30
Microsoft SQL Server Desktop 

Engine, 48
Microsoft Visual J# .NET, 48
Microsoft Windows

Automatic Updates, 46
Display settings, 47
Fonts removal, 47
network connection Windows, 46
Power Options, 47
printer install and configure, 47
set screen saver, 47
set time and date, 47
System Properties, 47
Tab settings, 47
user accounts, 46
virus protection, 46

Microsoft Windows XP system 
settings, 46

mouseless help system use, 64
mouseless Windows navigation, 64
MSSQL$CDF service, 48
My Documents location, 57

N
N9020A

Computer Name, 73
computer name, 70
Domain Name, 73
internet access, 82
popup menus, 76
virtual front panel, 81
web access, 82
windows system, 63

N9060A software, 38
navigating

tables, 31
navigating without a mouse, 64
network connection, Microsoft 

Windows, 46

O
operating remotely, 68
operating system, 63
overview, keys and key menus, 30

P
packaging, 105
partitioning the hard-disk drive, 48
passwords, 40, 41
Performance settings, Microsoft 

Windows, 47
power cords, 24
Power Options, Microsoft Windows, 47
power source, 23
power-on time, 22
print screen, 93
printer driver loading, 49
printer install and configure, Microsoft 

Windows, 47
printer setup, 49
printing a window, 93
printing the desktop, 93
problems with shipment, 11
program storage, 57

R
rack mounting, 11
rear panel

symbols, 36
rear panel features, 34
recovering the hard drive, 59
recovery process, 60
recovery timing, 61
reduce power-on time, 22
registry entries, 48
Remote Desktop

Installing, 70
keycodes, 77
running, 72
Setting up, 70

Remote Operation
Connection Speed, 73

remote operation, 68
embedded web server, 82
internet access, 82

repair tag, 104
replacing battery, 24
restoring your instrument, 55
running Windows without a mouse, 64

S
saving a window image, 93
saving data to internal drives, 57
saving programs on C drive, 57
saving the desktop image, 93
SCPI

Telnet Control, 90

Screen Capture, 88
screen capture, 93
screen resolution setting, Microsoft 

Windows, 47
screen saver settings, Microsoft 

Windows, 47
security, 51
service options, 103
service tag, 104
services running, 48
setting

gateway, 50
hostname, 50
ip address, 50
LAN, 50

shipment contents, 10
Shortcut keys

Windows, 94
shortcut keys, 77
software installed by customers, 39
software licenses, 38
spectrum analyzer software, 38
spyware, 54
Startup and Recovery settings, Microsoft 

Windows, 47
Startup Folder

Windows, 97
storing data on D drive, 57
symbols, on front and rear panels, 36
system backup, 55
System Properties, Microsoft 

Windows, 47
system recovery, 59
system restore, 55
system settings that can be changed, 46

T
tab key, 31
Tab settings, Microsoft Windows, 47
table

navigation, 31
Taskbar

Windows, 95
third party software, 39
time and date setting, Microsoft 

Windows, 47
turn on

with a mouse, 12
without a mouse, 17

U
updates, automatic, 46
updating Windows, 52
URL, sales and service, 103
USB broken, 56
USB drivers, 56
USB host ports, 56
USB Series A or B ports, 56
User Accounts location, 57
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user accounts, Microsoft Windows, 46
user logon, 40
user logon accounts, 41
User Profiles settings, Microsoft 

Windows, 47
user startup folder, 97
using help without a mouse, 64
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using Windows without a mouse, 64

V
vector signal analyzer software, 38
verifying contents, 10
virtual front panel, 81
virus protection, 39, 53
virus protection programs, 46

W
warranty, 103
WCDMA software, 38
window saving, 93
Windows, 64

Automatic Updates, 46
Control Panel, 95
Display settings, 47
Fonts removal, 47
Power Options, 47
print screen, 93
printer install and configure, 47
Screen Capture, 88
screen capture, 93
set screen saver, 47
set time and date, 47
Shortcut keys, 94
Startup Folder, 97
System Properties, 47
Tab settings, 47
taskbar, 95
user accounts, 46
virus protection, 46
XP, 63

Windows Classic Style, 47
Windows firewall, 52
Windows Remote Desktop, 68

keycodes, 77
options, 73
Options Dialog, 73
popup menus, 76
running, 72
Setting up Remote Computer, 70
setting up the N9020A, 68
Setting up Windows Systems, 70
virtual front panel, 81

windows security, 51
Windows services, 48
Windows updates, 52
Windows XP settings, 46
Windows XP Style, 47
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